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be present in this PDF version. Those topics can be successfully printed from within the online help.
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About Service Manager
HP Service Manager is a comprehensive and fully-integrated IT service management software suite that

enables you to improve service levels, balance resources, control costs, and mitigate risk exposure to an

organization. Service Manager enables you to manage services using a "lifecycle" approach, with

consistent improvement built into the governance model.
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Accessing HP Service Manager
The way that you access HP Service Manager depends on which of the following types of client you want

to use:

l "Log on to the web client (power user view)" on page 12

l "Log on to the web client (self-service user view)" on page 13

l "Log on to the web client (accessible views)" on page 14

l "Log on to the Windows client" on page 15

For more information about each type of client, see "Clients" on page 22.

Logging on from the web client
The HP Service Manager web client has four views (modes):

l Power User view (index.do)

l Employee Self-Service User view (ess.do)

l Accessible view (accessible.do)

l Self-Service Accessible view (accessible-ess.do)

These views are intended for different users. For details, see "Web client views" on page 24.

Web browser session management

Prior to Service Manager version 9.31, if you log in to the Service Manager web client and then open a

new web client tab sharing the same session, the session may collide, and unexpected behavior occurs.

For example, if you log in to the web client in Power User mode, and then open another page in Self-

Service User mode, the newly-opened page causes the original working page to automatically log out.

This may result in front tier data loss, depending on the application modes of the two pages. A typical

scenario is that you log in to the web client in the index.do mode, and then you attempt to open an

Incident record link in the ess.do mode from an HTML email notification.
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Service Manager versions 9.31 through 9.33 have solved this problem by allowing only one live web client

in the same browser session. When you open two tabs that share the same browser session, a warning

is displayed. You must save your work in the original working tab before you continue. For details, see

their specific online help. However, the functionality interrupts the workflow of the existing session and

the warning messages could be annoying.

As of Service Manager version 9.34, this functionality has been improved by optimizing the behavior in

the following two power user scenarios: a new tab or window (depending on your browser's setting for

opening external links) opens always in power mode without a warning, and the original working tab is

no longer expired: 

l Scenario 1: You log in through power mode first, and then click an email link in power mode as well.

l Scenario 2: You log in through power mode first, and then click an email link in self-service mode.

Note: In the following self-service user scenarios, Service Manager 9.34 or later behaves the same

way as in Service Manager 9.31 through 9.33. This is based on self-service user persona analysis

and the design that only one application thread is allowed in one user session for self- service

mode access to avoid potential data loss:

l Scenario 3: You log in through self-service mode first, and then click an email link in power

mode.

l Scenario 4: You log in through self-service mode first, and then click an email link in self-service

mode.

The following tables provide a comparison of the behaviors in different versions of Service Manager.

Scenario
Does a warning
display?

Is the original working
tab expired?

In which mode does the new browser
tab or window open?

1 Yes Yes Power mode

2 Yes Yes You are prompted to select one of the
following modes:

l Self-service mode (which requires a
re-login)

l Power mode

3 Yes Yes You are prompted to select one of the
following modes:

l Self-service mode

Table 1: Service Manager 9.31/9.32/9.33 behavior
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Scenario
Does a warning
display?

Is the original working
tab expired?

In which mode does the new browser
tab or window open?

l Power mode (which requires a re-login)

4 Yes Yes Self-service mode

Table 1: Service Manager 9.31/9.32/9.33 behavior, continued

Scenario

Does a
warning
display?

Is the
original
working
tab
expired? In which mode does the new browser tab or window open?

1 No No Power mode

Note: The new tab or window directly opens up to the linked
record, and retrieves only saved data of the pages that are
open in the first browser tab. Either continue to work in the
first tab, or save your changes in the first tab and then work in
the second one.

When you first log in through accessible mode, the behavior is
similar.

2 No No Power mode

Note: The new tab or window directly opens up to the linked
record, and retrieves only saved data of the pages that are
open in the first browser tab. Either continue to work in the
first tab, or save your changes in the first tab and then work in
the second one.

When you first log in through accessible mode, the behavior is
similar.

3 Yes Yes You are prompted to select one of the following modes:

l Self-service mode

l Power mode (which requires a re-login)

Note: The behavior is the same as in previous versions (9.31,
9.32, and 9.33). When you first log in through self-service
accessible mode, the behavior is similar.

Table 2: Service Manager 9.34 or later behavior
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Scenario

Does a
warning
display?

Is the
original
working
tab
expired? In which mode does the new browser tab or window open?

4 Yes Yes Self-service mode

Note: The behavior is the same as in previous versions (9.31,
9.32, and 9.33). When you first log in through self-service
accessible mode, the behavior is similar.

Table 2: Service Manager 9.34 or later behavior, continued

Note: This functionality also works as described in Table 2 when your system has Lightweight Single

Sign-On (LW-SSO) enabled or is horizontally scaled.

Limitations

l Process Designer workflow tab pages (Tailoring > Process Designer > Workflows) that are open in

the original browser tab cannot be recovered in the new browser tab.

l When you refresh the web client in the new browser tab by using the browser’s Refresh feature, you

may see a browser warning. Ignore the warning, and click Retry (in Microsoft Internet Explorer) or

Resend (in Mozilla Firefox) to continue.

l A warning page is displayed when you download files from the browser (for example, when you

export a record list to a text file). There are several workarounds to this issue. For example, you can

hold down the Ctrl key and click the OK button on the Export to Text screen, until the file download

dialog appears.

l In a trusted sign-on (TSO) environment, rapidly opening multiple links may cause unexpected errors

or a session timeout. This is because Service Manager creates a temporary session during login. If

you open multiple links too fast, the following issues may occur:

o The temporary session terminates at the server side after a successful login, and therefore all

requests with the temporary session may result in a logout. This logout will direct the web client

to a goodbye page, which will terminate your session at the server side.

If you have logged on to the web client, all subsequent requests will open up a warning page. Only

the most recent page is kept active, and the others expire.
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o Subsequent requests are sent before the first request is returned with a temporary session.

Therefore, the server does not know if these requests are from the same browser session.

o If you log on to the web client, all subsequent requests will result in a warning page. Only the

most recent page is kept active, and the others expire.

Log on to the web client (power user view)

To log on to the power user view of the HP Service Manager web client, follow these steps:

1. Contact your system administrator to obtain the following information about the Service Manager

server to which you want to connect:

o The web server host name or IP address

o The web server port number

o The name of the deployed Service Manager application

o Your user name and password

2. Verify that your web browser version is supported. For more information, see Compatibility

matrices.

3. Verify that your web browser is configured as follows:

o Cookies are enabled.

o JavaScript is enabled.

o Pop-ups are enabled. You may need to add the URL to the browser exception list.

o The Java plug-in is installed (if you want to use the graphical workflow feature in Change

Management or Release Management).

4. Type the following URL in the address field of your web browser:

http://servername:portnumber/appname/index.do

This URL contains the following placeholders:
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o servername refers to the host name or IP address of the web server.

o portnumber refers to the port number. For example, leave the port blank to default to port 80.

o appname refers to the name of the deployed Service Manager application. By default, the

application name is the name of the WAR/EAR file. For example, webtier-9.30.

Note:

o If your web client requires a secure connection, Service Manager automatically redirects

the URL to https://servername:HTTPSportnumber/appname/index.do

o You can append parameters to the URL to modify the web client appearance and behavior.

For example, you can specify the help server location so that the web client users can easily

access the Service Manager online help. See Setting web client preferences.

5. On the login page, type your user name and password.

6. Select the language for the web client. The language defaults to the language setting in the web

browser environment.

7. Click Log In.

Log on to the web client (self-service user view)

Access to the self-service user view is often configured as a link on an intranet web page. Contact your

system administrator for that information.

If you need to access the self-service user view by its URL, follow these steps:

1. Contact your system administrator to obtain the following for the HP Service Manager server to

which you want to connect:

o The web server host name or IP address

o The web server port number

o The name of the deployed Service Manager application

o Your user name and password
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2. Verify that your web browser version is supported. For more information, see Compatibility

matrices.

3. Verify that your web browser is configured as follows:

o Cookies are enabled.

o JavaScript is enabled.

o Pop-ups are enabled. You may need to add the URL to the browser exception list.

4. Type the following URL in the address field of your web browser:

http://servername:portnumber/appname/ess.do

This URL contains the following placeholders:

o servername refers to the host name or IP address of the web server.

o portnumber refers to the port number. For example, leave the port blank to default to port 80.

o appname refers to the name of the deployed Service Manager application. By default, the

application name is the name of the WAR/EAR file. For example, webtier-9.30.

Note: If your web client requires a secure connection, Service Manager automatically redirects

the URL to https://servername:HTTPSportnumber/appname/ess.do.

5. On the login page, type your user name and password.

6. Select the language for the web client. The language defaults to the language setting in the web

browser environment.

7. Click Log In.

Log on to the web client (accessible views)

Applies to User Roles:

All roles
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To log on to one of the accessible views of the HP Service Managerweb client, you must specify the

accessible keyword in the URL. Follow the same procedure to access the power user view or the self-

service user view, but modify the URL as described below.

To access the power user view in accessibility mode, use the following version of the power user view

URL:

http://servername:portnumber/appname/accessible.do

This URL contains the following placeholders:

l servername refers to the host name or IP address of the web server.

l portnumber refers to the port number. For example, leave the port blank to default to port 80.

l appname refers to the name of the deployed Service Manager application. By default, the

application name is the name of the WAR/EAR file. For example, webtier-9.30.

Note: If your web client requires a secure connection, Service Manager automatically redirects the

URL to https://servername:HTTPSportnumber/appname/accessible.do.

To access the self-service user view in accessibility mode, use the following version of the self-service

user view URL:

http://servername:portnumber/appname/accessible_ess.do

This URL contains the following placeholders:

l servername refers to the host name or IP address of the web server.

l portnumber refers to the port number. For example, leave the port blank to default to port 80.

l appname refers to the name of the deployed Service Manager application. By default, the

application name is the name of the WAR/EAR file. For example, webtier-9.30.

Note: If your web client requires a secure connection, Service Manager automatically redirects the

URL to https://servername:HTTPSportnumber/appname/accessible_ess.do.

Log on to theWindows client
To log on to the HP Service Manager Windows client, follow these steps:
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1. Contact your system administrator to obtain the following for the Service Manager server to which

you want to connect:

o The server host name or IP address

o The server port number

o Your user name and password

2. From the Windows Start menu, click All Programs > HP > Service Manager  x.xx > Client. This is

the default path for the client installation. Your path may be different.

3. Click File > Connect to display the Connections dialog box. From this window you can choose an

existing connection or create a new connection.
o If you want to choose an existing connection,select the connection name, and then click

Connect.

o If you want to create a new connection, follow these steps:

i. Click New on the Connections dialog.

ii. Specify the details for the connection. For more information about how to do this, see

"Create a connection" below.

iii. Click Connect.

Create a connection

Applies to User roles:

All roles

To create a connection, follow these steps: 

1. Click File > Connect > Connections.

2. Click New to create a new configuration.

3. Name your new configuration. Choose a name that reminds you what the configuration is for. If you

use multiple servers, you may want to include the server name in the configuration name. If you

use multiple login profiles, you may want to include the profile name in the configuration name.

For example, name the connection "servername admin" or "servername helpdesk."
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4. Type your user name and password.

5. Click Remember my password if you want to save your encrypted password.

6. Click Automatically login if you want to log on to this server each time that you start the client.

Omit this step if you want to choose a different server each time you connect to the server.

7. Type the server host name and the server port number. Contact your system administrator for this

information.

8. Click the drop-down list to choose your language. The server populates the list with its supported

languages. The default value is "English."

9. If you want the configuration to be identified by a background color in the HP Service Manager

client window, click Connection identified by color, and then choose a color.

10. Click Apply. For more information about options on the Advanced tab, see "Connections dialog"

below.

11. Click Connect to connect to Service Manager.

Connections dialog

When you launch the HP Service Manager Windows client, the Connections dialog box appears. You can

use the dialog box to set up new connection shortcuts to the server and to manage existing connections

shortcuts.

The Connections dialog box is important if you are an administrator using the Client Packaging Utility to

create a single branded installation.

Click the filter button to filter server connections so that only a few connections are displayed or a

specific connection is displayed. By typing the beginning letters or complete name of the connection in

the filter text box, so only those connections that match what you type appear in the list of server

connections.

Note: Some options may not be visible on a repackaged client.

The Connection tab on the Connections dialog box has the following options.
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Option
Default
value Definition

Name New_
configuration

Type the name of this connection.

Use
Login/Password

Enabled When this option is enabled, Service Manager uses the login name
and password information defined in the Connection dialog to
create a client/server session.

Use Trusted
Sign-on

Disabled When this option is enabled, Service Manager uses the login name
and password information defined in a trusted authentication
source, such as Windows Integrated Authentication, to connect to
the server.

User name Windows
user name

Type your user name to log on to the named server.

Password None Type your password to log on to the named server.

Remember my
password

Disabled Select this option to log on automatically without retyping your
user information each time.

Automatically
login

Disabled Select this option to log on automatically when you start the
Service Manager client.

Server host
name

localhost Type the name of the Service Manager server.

Server port
number

13080 Type the port number assigned to the Service Manager server. The
default Service Manager port number is 13080.

Language None Choose the language to use for this session. You may want to
create session connections in multiple languages if you work with
international customers.

Connection
identified by a
color

Disabled This option enables you to assign a different color to each
connection. By default, all client connections have the same
background color as your Windows text editor.

Connection
color

None Choose a standard or custom color from the color palette.

Tip: A custom color can improve the contrast or identify
multiple connections. Lighter colors improve the readability of
the forms.

Advanced tab

The Advanced tab on the Connection dialog has the following settings.
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Option
Default
value Definition

Compress SOAP messages Enabled When this option is enabled, SOAP messages are compressed
by using GNU zip (gzip) encoding. Gzip works similarly to
WinZip™, a compression utility for Windows.

Note: You can disable this option globally in the sm.ini
file.

Use SSL Encryption Disabled When this option is enabled, server’s demonstration
certificate is used to encrypt your data when transmitting it.

Note: You can enable more robust SSL encryption
options from the sm.ini file.

Trace SOAP traffic Disabled When this option is enabled, the client logs SOAP messages.

Connect to External Load
Balancer

Disabled When this option is enabled, the Windows client supports an
external hardware load balancer.

Multiple sessions

HP Service Manager supports the following login scenarios.

Windows client

l After you log in to Service Manager by using the Windows client, you can log in again to the same

server with the same (or a different) user name and run multiple concurrent sessions.

l After you log in to Service Manager by using the Windows client, you can log in again to different

servers with the same (or a different) account and run multiple concurrent sessions.

Each session runs in a separate window. If you disconnect one client/server session, the associated

window is closed, but all others remain open until you disconnect the relevant session. When you create

a connection profile, you can specify a custom color to easily differentiate one connection from

another.

Web client

Service Manager does not support multiple web client sessions.
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Log off Service Manager
Applies to User roles:

All roles

It is important that you first disconnect or log off Service Manager before you exit the Windows or web

clients.

Windows client

To log off the Service Manager Windows client, follow these steps:

1. Click File > Disconnect from <connection name>.

2. Click File > Exit.

Web client

To log off the Service Manager web client, follow these steps:

1. click User Information on the top-right corner of the Service Manager UI to show your User Basic

Information Card.

2. Click Logout, and then click OK to confirm that you want to log out.

3. Close the web browser.

Passwords
Passwords play a major part in controlling system security within HP Service Manager. To protect your

Service Manager system from unauthorized access, each user has a password.

A system administrator can change any password. Users can also change their own passwords, unless

the system administrator denies that right.
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Change my password

Applies to User roles:

All roles

You can use the command line (if this feature is enabled for you) or the Change Password option in the

ESS client to change your password.

To change your password by using the command line, follow these steps:

1. On the web client or the Windows client, type password in the command line field. The Change

Password form opens, and Service Manager displays the password form with your user name.

Note: This option is available only if your administrator has given you access to the Service

Manager command line.

2. Type your old password in the Old password text box.

3. Type your new password in the New password text box.

4. Re-type your new password in the Confirm new password text box.

5. Click OK.

To change your password by using the ESS client, follow these steps:

1. Log on to the ESS client.

2. Click Change Password on the navigator.

3. Enter your old and new passwords, and save the change.

The new password is required the next time you log on. If you start another session while the current

session exists, you must use the new password. If you have a connection defined in the Connections

dialog box, you must update the logon password in that dialog box and click Apply to save the

connection information.
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Clients
HP Service Manager includes the following two client interfaces:

l A web client that runs in a web browser and accesses the Service Manager server through a URL.

l A Windows client that runs as an application on a Windows host and accesses the Service Manager

server through a client/server connection.

The following diagram illustrates how each type of client connects to the Service Manager server.

Both clients provide end users access to the Service Manager applications. The Windows client, however,

offers additional functionality, such as the ability to create forms and access the database dictionary.

The Windows client is intended for administrators and implementers.
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Web client
The web client offers the same basic features as the Windows client, but provides a different look and

feel, tree view navigation, and other features.

The web client is the only HP Service Manager client that runs on a non-Windows platform. The web

client supports accessibility and meets Section 508 requirements. For more information, see the

Accessibility Guide.

Web client setting requirements

Verify the following before using your web client.

l Enable cookies.

l Enable JavaScript.

l Enable pop-ups in all browser versions. You may need to add the Service Manager URL to the

browser exception list.

l To use the graphical workflow feature, install the Java plug-in according to the instructions in the

Interactive Installation Guide.

Verify that your browser version is compatible by checking the Service Manager product Support Matrix

on the HP Customer Support website.

Note:

l The web client does not support multiple logins. Therefore, you should ensure that you only log

on to Service Manager once in your browser, as browser sessions are not independent and

multiple logins result in unpredictable system responses.

l Do not use the buttons (such as Refresh, Back, and Forward) on your browser toolbar or their

keyboard shortcuts (such as Ctrl+R, Ctrl+Left, and Ctrl+Right) to perform Service Manager

actions. Instead, use the buttons on the Service Manager interface, as described in "List and

detail toolbars" on page 46.
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Web client views

The web client offers several different interface views. The following views are included in out-of-box

installations of HP Service Manager:

Web
client
view Description

Power
user

This web client view is the standard interface. It most closely matches the Windows
client and is intended for Service Desk technicians, managers, and administrators.

Accessible This web client view is a modified version of the power user view with record list mode
turned off, high contrast colors, and larger fonts. This view is intended for Service Desk
technicians, managers, and administrators who need accessibility features.

Employee
self-
service
(ESS)

Standard ESS View: provides a simplified Service Desk interface for users to create,
view, and update service requests. Intended for end-users as an entry point to Service
Desk.

Note: The ESS interface is designed so that users can easily understand what they
need to do; therefore, no Service Manager help icon is available. If users want to
see the online help, their System Administrator can provide them with a URL that
they can enter into their web browser.

Service Request Catalog (SRC): provides an employee self-service (ESS) web client
interface, which allows users to create, view, and update service requests. Users are
guided through request creation in questionnaire style, which enables the service
request to be created more quickly and accurately. Self-service support for catalog and
non-catalog items, approvals, and approval delegation is also provided. A dashboard
shows the status of service requests and catalog requests. An Assistance panel provides
quick and easy access to SRC online help.

Note: For more information, see HP Service Request Catalog for Service Manager.

Accessible
self-
service

This web client view is a modified version of the self-service user view with high contrast
colors and larger fonts. This view is intended for end-users who need accessibility
features.

Each of these views has default behavior and appearance. Administrators can customize the views by

setting web client preferences in the web.xml file. In addition, administrators can customize the web

client interface by creating custom style sheets and images.

Each view is accessed by a different kind of URL. For more information, see "Accessing HP Service

Manager" on page 8.
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Note: Service Manager also has a web interface for mobile clients. The mobile client interface runs

on smartphones and supports key tasks of the Change Management and Incident Management

applications. This interface requires setup and configuration. For more information about how to

do this, see HP Service Manager Mobile Applications.

Parts of the web client interface

The following image illustrates where you can find the main components of the HP Service Manager web

client interface:

The numbers in the image above represent the following components.

Component Description

1 System Navigator. Provides navigation through the Service Manager applications and
their forms.

2 Record List toolbar. Contains commands that affect the record list portion of the
editor. Click the More button to access additional commands.

3 Record List area. The record list is populated after you execute a Search command.
The currently-selected record that in the record list is displayed for editing directly
below the record list, in the record detail area.
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Component Description

4 Detail List toolbar. Contains commands that affect the record that is opened for
editing, in the record detail area.

5 Record Details area. Displays the record that is selected in the record list area.

6 Command/Search line. Allows you to enter shortcut commands or record's prefix and
IDs. Click the Command/Search line toggle button to switch between the Command line
and the Search line.

Note: The Command/Search line toggle button is available in the web client only
and is disabled by default. For more information about how to activate this button,
see the "Activate the command/search line toggle button" topic.

Horizontal and vertical layouts

The HP Service Manager web client provides the following two layouts for a list-detail page:

l Horizontal layout: In the horizontal layout, the record list pane is above the record detail pane. This is

the default layout of the list-detail page.

l Vertical layout: In the vertical layout, the record list pane is on the left side of the record detail pane.

You can use the switch to toggle between the two layouts.

Your web browser stores the following layout information of your current login session:

l Horizontal layout or vertical layout

l Columns and the width of each column

In a newly opened page or in your next login, the web client can keep the same layout. If you clear the

cache of the web browser, the web client uses the horizontal layout.

Hover information in the vertical layout

In the vertical layout, the content in the first column appears as links. When the mouse hovers over one

of these record links, a hover window appears and displays the values of all columns. Hidden columns

are displayed below a separation line.

To customize the fields that the hover window can display, follow the instructions in "Create customized

column views for record lists" on page 69.
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Accessibility

When Section 508 became an addendum to the Rehabilitation Act of 1973, it required United States

federal agencies to make electronic and information technology usable by anyone with a disability. The

HP Service Manager web client meets this requirement.

The web client provides support for accessibility in the final software product. When software contains

these accessibility features, assistive technology vendors can customize the look-and-feel of the

software to support non-visual presentation with audio or with other devices.

For more information about the Service Manager statement of compliance with respect to Section 508

of the ADA, and for details relating to the specific accessibility requirements of that regulation, go to

the HP Customer Support website.

Client differences: the accessible and standard Web clients

The accessible web client enables users with special needs to use HP Service Manager. The accessible

client includes the following features:

l Larger default fonts

l The ability to increase the browser font size

l Larger form spacing

l Simplified navigation

The following differences exist between the accessible and standard web clients:

l The accessible web client does not support the graphical workflow feature.

l Thread navigation links (the tabs that identify open forms) are not available in the accessible web

client.

HP Service Manager Accessibility Guide

HP Service Manager has an accessible web client that meets the needs of Section 508 of the American

Disabilities Act (ADA). The HP Service Manager Accessibility Guide contains information for users who

want to use the product in accessible mode, along with detailed information for Service Manager

administrators.
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You can view and search this guide using Adobe® Reader, which you can download from the Adobe

website.

The HP Service Manager Accessibility Guide is available from the online help.

Using the web client in accessible mode

You can use HP Service Manager in the web client’s accessible mode if you log in by using an accessible

URL. The following table describes how to use Service Manager in accessible mode.

Accessibility
feature Notes

Tabbing To move the focus into a field, press the Tab key until it reaches that field.

To return the focus to the previous location, press Shift+Tab.

Note: On some forms, there may be fields that are not displayed. In this case,
tabbing does move focus to the invisible field until you press the Tab key again.

Selecting
text

To select text, use the standard operating system keystrokes.

Service
Manager
buttons

To access the Service Manager button actions, press Enter when the focus is on the
button.

Alternatively, use the Service Manager keyboard shortcuts or web client keyboard
shortcuts.

Text area To tab to the next text area, press the Tab key in Internet Explorer or Shift+Tab in
Firefox.

To tab to the previous text area, press Shift+Tab.

Collapsible
groups

Use the Tab key to navigate between collapsible group titles.

When the group title you want is in focus, press Enter to expand the group.

Check boxes To change the value of a checkbox, move the focus to that checkbox and press Space.

Radio
buttons

To select a radio button from a group of buttons, press the Tab key to until the focus
is on one of the radio buttons. Then press the Left/Right Arrows until the focus is on
the one that you want to select.

Detail tab
headers

You can only shift the focus to the header of an active tab. When the focus is on the
header of an active tab, you can use Left/Right Arrows to switch to other tabs.
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Web client keyboard shortcuts

This section introduces keyboard shortcuts for the HP Service Manager web client.

Keyboard shortcuts for general operations

You can customize these Service Manager web client keyboard shortcuts from the shortcut.xml

configuration file. By default, most of the web client shortcuts use the Alt key plus a character to

produce a combined keystroke.

The following table shows the default actions assigned to the keystrokes, but your own browser may

override these actions.

Area
Keyboard
shortcut Name in shortcut.xml Action

Navigation
through
sections

Alt+Ctrl+N keyNavigator Move the focus to the first toolbar button in
the navigator

Alt+Ctrl+M keyMainContent Move the focus to the first toolbar button in
the main content pane

Alt+Ctrl+L keyList Move the focus to the first toolbar button in
the list pane (when the current page is a list-
detail page)

Ctrl+Alt+D keyDetail Move the focus to the first toolbar button in
the detail pane (when the current page is a
list-detail page)

Alt+Q keyTabSections Navigate through the following panes (not
including the toolbar buttons):

l Navigator + main content pane

l Navigator + list pane + detail pane (if the
active tab page is a list-detail record list)

Note: When you navigate from one pane
to another by pressing Alt+Q, the focused
element in the original pane is
remembered. When you return to the
original pane by pressing Alt+Q again, the
focus is set on the remembered element.
If no element in the original pane was
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Area
Keyboard
shortcut Name in shortcut.xml Action

focused, the focus is set on the frame
window of the pane. However, if the
original pane is refreshed, the focus is set
on the first element of the navigator
pane or the frame window of the main
content pane, list pane, or detail pane.

Alt+Ctrl+H keyFocusTabHeader Move the focus to the header of the current
active tab

Alt+Ctrl+T keyCloseActiveTab Close the current active tab

Note: You cannot use this shortcut to
close the first To-Do queue tab.

Navigation
Menu

Alt+1 keyManageFav Open the Manage Favorites pane

Alt+2 keyAddListFav Add a favorite that links to the current list

Alt+3 keyAddDetailFav Add a favorite that links to the current record

Alt+N keyCollapseExpandNav Switch the System Navigator between the
expanded mode and the collapsed mode

Record list Alt+U keyToggleList Expands or collapses the List Pane in a list
detail page

Detail Form Alt+J keyJumpAddress l Move the focus to the drop-down list

l Expand or collapse the drop-down list

Alt+C keySpellCheck Open the Speck Check utility

F1 functionKeyHelp View help on field

F2 functionKeyMagnify Expand a scrollable text field by opening a
separate window that magnifies the text for
easier viewing and editing
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Area
Keyboard
shortcut Name in shortcut.xml Action

Miscellaneous Alt+G keyMessages Open or close the Messages and Alerts window

Alt+P keyPrint l Print the current page content

l Print the current record when the current
page is a list-detail page

Alt+Ctrl+P keyPrintList l Print the current page content

l Print the list when the current page is a
list-detail page

Alt+O keyAbout Open the About HP Software window and
display the installed HP Service Manager
components

Alt+R keyRefresh Refresh the current screen

Note: Do not refresh Service Manager
screens by refreshing your browser.
Instead, use the Service ManagerRefresh
button or shortcut (Alt+R).

Alt+L keyLogout Open the logout dialogue

Alt+Ctrl+/ keyShortcut Show or hide system keyboard shortcut list

Keyboard shortcuts for date picker

The Service Manager web client provides a date picker widget that assists you to input date and time.

The following table shows the keyboard shortcuts for the date picker widget.

Keyboard shortcut Action

Esc Close the date picker widget without
selection

Enter Choose the highlighted date

Shift+Enter Choose today

Left Arrow Previous day

Right Arrow Next day

Up Arrow Previous week
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Keyboard shortcut Action

Down Arrow Next week

Shift+Left Arrow Previous month

Shift+Right Arrow Next month

Shift+Up Arrow Previous year

Shift+Down Arrow Next year

Tab Switch focus between date and time

Down Arrow (when the focus is on the time field in the date
picker widget)

Open the time list

Enter (when time list is open) Choose highlighted time

Keyboard shortcuts for list builder

The list builder widget allows you to construct a list of choices. The following table shows the keyboard

shortcuts for the list builder widget.

Keyboard shortcut Action

Left Arrow

Right Arrow

Up Arrow

Down Arrow

Select items in the list builder

Shift+Left Arrow

Shift+Right Arrow

Move the selected item to the left or right column

Shift+Up Arrow

Shift+Down Arrow

Move the selected item up or down in the right column

Quick help for keyboard shortcuts

In the web client, you can open quick help to view the keyboard shortcuts for the web client. To do this,

use one of the following methods:
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l Click the Help button

o If the web client does not have online help, the shortcut list directly opens.

o If the web client has online help, a drop-down menu appears. Click Shortcut List from the drop-

down menu.

l Use the keyboard shortcut: Alt+Ctrl+/

You can adjust the size of the list or move the list to anywhere within the browser window. When the

browser window resizes or you open the list again, the list restores to the default size and position.

The keyboard shortcuts that the quick help presents are based on the settings in the shortcut.xml file.

If the configuration of the shortcut.xml file is incorrect, the quick help displays an error message.

Windows client
HP Service Manager includes both Windows and web clients. The Windows client is intended for

administrators and implementers, while the web client is suitable for most end users. The Windows

client enables you to design forms and work with the dbdict; capabilities that are not available to web

client users.

The Windows client includes the following features:

Interface

l A dynamic user interface that you can customize (by using preferences) to change the way you

interact with perspectives and views

l Windows client update capability

Client/server connection

l A Connection dialog that enables you to define multiple connections to different servers and saves

them from one session to another

l Automatic connection for connection profiles with the automatic logon option enabled

System Navigator

l Favorites folder to save shortcuts to frequently used applications, forms, and queries

l Simplified access to forms, files, and records through the System Navigator
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Applications

l Application-specific user interface elements

l A graphical workflow used by the Request and Change Management applications

l Charts and dashboards to show data graphically

Help

l Field help

l Help for end users and administrators

Other features

l UTF-8 (Unicode) support to display data in any language

l SOAP-based client/server communication

l Automatic reconnection of client/server sessions after brief network connection disruptions

Windows client features

Feature Functionality

Window
design

You can drag and drop client components to arrange them in the following ways:

l Drag the title bar (or tab) of any view to a different position within the client
window.

l Drag any view or editor outside the client window.

l Drag any view to the shortcut bar for a Fast View.

l Drag the shortcut bar to dock on the right, left, or bottom of the client window.

l Resize any view or editor by dragging the split bar up, down, or sideways.

l Drag any view to a vertical or horizontal position in the client window.

Views Views have a minimize and maximize button. Click Maximize to fill the client
window. Click Minimize for the view to appear as a tab in the lower right section of
the editor. You can hide a view if you right-click and choose Fast View.

Views for all
users

Dashboard
Messages
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Feature Functionality

Secondary System Navigator
System Navigator

Views for
administrators

Console
Detail Data
Detail Form
List Data
List Form
Request
Response
Stopwatches

Fast views Right-click any Fast View icon to change the docking position of the shortcut bar.
You can choose left, right, or bottom.

Editor tabs If you drag multiple views or editors to the same location, they arrange themselves
in a tabbed notebook format.

Perspectives The Administration perspective contains views for administrators only. You must
have the Admin plug-in installed to access this perspective.

Parts of the Windows client interface

The following image illustrates where you can find the main components of the HP Service Manager

Windows client interface:
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The numbers in the image above represent the following components.

Component Description

1 Shortcut bar. Shortcuts to different perspectives and views. For more information, see
the "Shortcut bar" topic.

2 Menu bar. Menus of commands that apply to or affect the Windows client.

3 Command line. Quick access to areas of Service Manager brought up by entering the
command for them. For more information, see the"Enable an operator to see the
command line" topic.

4 Tool bar. Commands and operations that are not specific to the current editor.

5 Editor Tool bar. Commands and operations that are specific to the current editor. The
editor is determined by the type of entry selected in the System Navigator tab.

6 System Navigator. The forms available to the user, grouped by their applications.

7 Form open for editing. The current form being edited.

The Windows client interface also has views and perspectives. See the related topics for more

information.

All of the views, perspectives, and editors are collectively called the workbench.
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Workbench

Note: The workbenches is a Windows client-only feature.

The workbench is the window that contains all the HP Service Manager interface. Its primary panes are

views (such as System Navigator or Properties) and the editor.

The workbench uses perspectives to organize the views and the editor into task-oriented

configurations. It changes the title bar according to your perspective and what form you use. You can

also configure the workbench in the preferences. The form name appears at the bottom right corner of

the workbench.

When you open a connection to a different server or to the same server, you open a new workbench.

There is no limit to the number of workbenches you can have open at one time, although you can only

run one client at a time.

SystemNavigator

The System Navigator is a visual hierarchical structure that enables you to navigate through HP Service

Manager applications and to drill down into the system to access forms and other information. You can

drag and drop favorites (such as queries, lists, and forms) into the System Navigator view, store charts

and dashboards, access Service Manager applications, and complete database tasks.

Administrators can configure user roles with permissions that enable or disable viewing of System

Navigator components. For example, some users should not have direct access to database information

or be able to create public folders.

Some available actions appear on the System Navigator contextual (right-click) menu. The list of actions

varies, depending on user roles and the current task. The following table describes two of the

commands found in the System Navigator contextual menu.

Command Definition

New
(favorites or dashboards)

Creates a new folder or dashboard.

Refresh  Refreshes the display.

Note: Do not refresh the System Navigator by refreshing your
browser. Instead, use the Service Manager System Navigator
Refresh button.
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Client differences: System Navigator

The following differences between the System Navigator of the Windows client and of the web client

occur because the browser environment is different from the Windows client environment.

Feature
Windows
client?

Web
client? Comment

Create
favorites

Yes Yes Favorites are restricted to lists, detail, and menu screens.

Windows client

From a record list, application, or form, drag the System
Navigator icon to the Favorites folder, or to a subordinate folder. 

Web client

From a record list, click Save as View.

Create
subordinate
nodes

Yes Yes You can customize the System Navigator by adding a folder.

Windows client

Right-click the parent node to make a new folder.

Web client

1. Click Manage Favorites. 

2. Expand the Favorites directory to locate the parent node.

Click New Folder. 

3. Type the name of the new folder and click OK.

Delete nodes Yes Yes You can customize the System Navigator by removing nodes.

Windows client

Right-click to delete nodes from the System Navigator.

Web client

1. Click Manage Favorites. 

2. Expand the Favorites directory, select the node to delete,
and then click Delete.
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Feature
Windows
client?

Web
client? Comment

Collapse All Yes No You can collapse subordinate nodes when you select a parent
node.

Windows client

Right-click the parent node, and then click Collapse All to close

all subordinate child nodes. 

Web client

Collapse All is not available for the web client.

Editor

The following image illustrates different parts of the editor:
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The editor is the primary pane in which you can edit forms and work in HP Service Manager applications.

Service Manager opens new editors as needed. You can drag and drop editors to display them side–by–

side or stacked in a tabbed notebook. Click any tab to move that editor to the top of the stack.

Editor toolbar

The editor toolbar contains the tools that are used by associated applications. The tools that are

available change depending on the Service Manager application and the current task.

The editor toolbar also contains the following icons:

l The Favorites icon ( ). Drag this icon to the Favorites folder to create a shortcut to forms or

applications. 

l The More Actions icon ( ). Click this icon to display a list of related Service Manager tasks. 

l The Menu icon ( ). Click this icon to rearrange the editor space. For example, you can re-locate or

hide the record list.

l Application icons. Click these icons to complete standard Service Manager actions.

The record list toolbar contains the following icons:

l The Favorites icon ( ). Drag this icon to the Favorites folder to create a shortcut to forms or

applications. 

l The Print icon ( ). Click this icon to send the current form to a networked printer. 

l The Count icon ( ). Click this icon to display the number of records in a record list. 

l The More Actions icon ( ). Click this icon to display a list of related Service Manager tasks. 

Service Manager toolbar

The Service Manager toolbar in the Windows client is located just below the main Menu bar. It contains

buttons that launch the Connections dialog, print, check spelling, open the field help, and close Service

Manager tools to use with Service Manager applications.

The toolbar also displays the Service Manager command line, if that privilege is granted on the Startup

tab of your operator record.
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Shortcut bar

Note: The shortcut bar is a Windows client feature.

When you create perspectives and collapsed views (or fast views), the icons for these views are

displayed in the shortcut bar. Storing fast views, including the System Navigator, on the shortcut bar

frees up more space for the editor.

To minimize a view that you opened from the shortcut bar, click the editor.

Icon Option Definition

Minimize option Minimizes the pane into the shortcut bar

Close option Closes the view and remove it from the shortcut bar

Each view has additional options and menus, according to its purpose.

Fonts

Using font styles (for example, bold or italics) affects the spacing of the characters on a form. If labels

in forms are truncated, select a different font, style, or size. You can also increase the width of the form

to accommodate a different font, style, or size. To do this, specify an increased width percentage in the

HP Service Manager preferences.
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Help menu

The Help menu has six selections.

Menu item Description

Help Contents  Open the Help window. The Help system must be install for this to be enabled.

Help on Field  View pop-up help for the current field. Press Ctrl+H as a shortcut, or click the
Help on Field icon on the toolbar. This is not enabled on the out-of-box system.

Help on Form View pop-up help for the current form. This is not enabled on the out-of-box
system.

About  Service
Manager Client

Access version and copyright information; link to Hewlett-Packard or Eclipse.org.
You can also link to details about features, plug-ins, and configuration.

About  Service
Manager Server

Access information about the version, network address, host, port, hardware, and
operating system.

Forms

HP Service Manager displays forms in the Service Manager workspace. Each form has an associated

More Actions menu, which contains additional options for that form. The available options vary,

depending on the current Service Manager application and user profile rights.

To access menu options in a Windows client, right-click the form, and then choose an option from the

Context menu. Or, click the pull-down menu icon in the upper right corner of the workspace toolbar.

To access menu options in a web client, click More, and then choose an option from the More Actions

menu.

Link label

A link label provides a caption and an icon that links to another object, such as a wizard. Link labels are

enabled or disabled depending upon your actions in the associated object. For example, to add a new

filter to filter a long list of incidents, you create a filter in the Conditions table. If you specify no other

conditions, only the "Add New Filter Criteria" and "Add New Compound" links are enabled. After you add

new filter criteria, additional links (Edit Selection and Remove Selection) are enabled.

When a link is enabled, it is displayed in blue type and with a bright icon. When a link is disabled, the

link's icon and text are gray or dull.
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Drag–and–drop feature

The drag–and–drop feature moves or copies objects within the System Navigator in the Windows client

only. Your user rights determine what objects you can move and copy.

Option Definition

Copy

When you copy an object in the System Navigator, the mouse pointer icon changes to
include the pointer arrow, a small rectangle, and a plus sign.

Move
When you move an object in the System Navigator, the mouse pointer icon changes to
the pointer arrow and a small rectangle.

Forbidden When you do not have the user rights to move or copy, the mouse pointer icon changes
to a circle with a slash.

Note: In the web client, you can use Manage Favorites to move or copy nodes. 

Windows client keyboard shortcuts

The following are the Windows client keyboard shortcuts.

Keyboard
shortcut Action

Ctrl+F6 Cycle through multiple Editor panes.
This is similar to the Alt+Tab functionality in Windows.

Ctrl+F7 Cycle through multiple views.
This is similar to the Alt+Tab functionality in Windows.

Ctrl+F8 Cycle through multiple perspectives.
This is similar to the Alt+Tab functionality in Windows.

Ctrl+H View help on field.

Ctrl+S Spellcheck.

Ctrl+Shift+M Expand a scrollable text field by opening a separate window that magnifies the text
for easier viewing and editing.

Ctrl+Shift+Tab When the current focus is on a notebook page, this keyboard shortcut allows you to
move back to the previous notebook page.

Ctrl+Tab When the current focus is on a notebook page, this keyboard shortcut allows you to
select the next notebook page.
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Keyboard
shortcut Action

Ctrl+U Expand or collapse the status of the list frame in a list detail page.

F12 Transfer focus from the left navigation pane to the main viewing pane.

Differences between theWindows and web clients
The web client offers the same basic features as the Windows client. Each client also has unique

features.

Feature
Windows
client?

Web
client? Comment

Accessibility support No Yes

Charts Yes Yes You cannot change chart colors in the web client.
The Context (right-click) menu is not available. You
can use favorite properties to edit chart properties
if you make the chart a favorite.

Collapsible Groups No Yes In the web client, groups can be displayed as
collapsible sections on forms. In the Windows clients,
groups are expanded and cannot be collapsed by the
user.

Computer Telephony
Integration (CTI)

Yes Yes The web client is not multi-threaded for CTI.

Note: Before the web client allows you to take a
new call, it prompts you to save your work. If
you do not save your work before taking the
call, your work is lost.

Count records Yes Yes Windows client:  Click Count on the right side of the
record list toolbar. 

The Windows client displays the total number of
records to the right of the Count icon.
Web client: There are two ways to count records in
the web client.
1. Click More, and then Count. The web client

displays a message with the total number of
records

2. From the paging control on the bottom of the
record list frame, click the Count Records
button. The web client displays the total number
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Feature
Windows
client?

Web
client? Comment

of records to the right of the Count Records
button in the paging control.

Database administration Yes No

Debugger Yes No

Dynamic Data Exchange
(DDE) support

Yes Yes
Note: DDE is available in the web Client only in
the CTI interface.

Employee self-service
mode

No Yes A simplified interface to submit requests to Service
Desk.

Export lists to Excel Yes No
Note: The web client can only export lists to text
files, which you can manually import to Excel.

Forms designer Yes No

Multi-platform client
support

No Yes Use a supported web browser listed in the Service
Manager product Support Matrix on the HP
Customer Support website.

More Actions menu Yes Yes Windows client: Click the down-arrow icon in the
upper right corner. 
Web client: Click the More button on the detail or
record list toolbar.

Right-clicking (to open
the More Actions menu)

Yes No Windows client: Right-clicking in a form displays the
More Actions menu for that form, and right-clicking
in a record list displays the More Actions menu for
that record list.
Web client: Right-clicking a form or record list
displayed in the web client does not open the More
Actions menu. Instead, the web browser's context
menu opens.

System tailoring Yes No

System Definition
utility

Yes No You must enable the Administration plug-in.

URL navigation No Yes

Mandatory fields Yes Yes Windows client:  Indicated by a small red triangle in
the upper left hand corner of the field
Web client:  Indicated by a red asterisk to the left of
the field
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List and detail toolbars
Toolbars are displayed above the record list and record details sections of HP Service Manager

applications. These toolbars use standard buttons to trigger common actions. Some of the actions are

listed below.

Note: If you are using a web client, do not use the browser buttons (such as Refresh, Back, and

Forward) on your browser toolbar or their keyboard shortcuts (such as Ctrl+R, Ctrl+Left, and

Ctrl+Right) to perform Service Manager actions. Instead, use the buttons on the Service Manager

interface.

Windows
Client

Web
Client

Icon
name Meaning

Add Add a new record to the database.

Back Return to the last form.

Cancel Reverse your last action.

Clear Erase the data that you type on a form.

Close Change the status of the current record.

N/A Count Count the number of records in a record list. If you are using a web
client, you can access this information by clicking the Count Records
below the record list.

Fill Populate the current field with data.

Find Locate related data.

N/A Menu Refresh the record list and option list.

New Create a new record.

Next Advance to the next record.

Save
and Exit

Update the current record and return to the previous form.

N/A More
Actions
menu

Access the additional actions available for the current form. This icon
is located on the far right side of the toolbar in the Windows client.
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Windows
Client

Web
Client

Icon
name Meaning

N/A MORE More
Actions
menu

Access the additional actions available for the current form. This
button is displayed in the web client only.

Previous Return to the previous record.

Print Send the current form to the printer.

Qopen
(Quick
Open)

Create a service desk interaction or incident report.

Refresh Update to display changes.

Save Update the current record and display the current form.

Search Generate a record list.
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To Do list
The To Do list is the first screen all HP Service Manager users see when they log in to the Windows

client. Users who log in to the web client will also see a To Do list, unless they are using an operator that

has been set up to see a dashboard home page instead.

The To Do list displays a list of records in the operator's To Do queue. The operator can use the Queue

and View fields to display different record lists, depending on the selections made in each of these

fields. The operator's user role and profile determine the selections available in the Queue and View

fields.

For example, an operator might select the Interaction queue in the Queue field and Self-Service

Interactions in the View field to display a list of all open self-service interactions to which the operator

has access. Once a list of records appears, the operator double-clicks a record to display the details of

the record.

The To Do list includes active links on the left-side of the form that allow an operator to perform tasks,

such as searching for or creating a new record, depending on the queue and view selected and operator

access privileges.
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Searching records
HP Service Manager enables you to search for a specific record or set of records in a table. The system

provides a search form in which you can specify search criteria to narrow the search. The tables in which

you can search depend upon the access rights that you are assigned. For example, if you have limited

rights, you may be limited to searches in interaction records or incident records only. However, a system

administrator can search most, if not all, tables that are available for record searches.

Search for a record by using the Search line
Applies to User Roles:

All roles

The Quick Ticket Search feature in HP Service Manager provides a Search line from which you can

access single records. This enables you to simply enter the record ID and open the associated record

directly, without having to navigate through menus.

To search for a record using the Search line, follow these steps:

1. If you have access to the Service Manager command line, click the Command/Search line toggle

button to switch to the Search line. If you have no command line access, a Search line box is

already available.

Note: The Command/Search line toggle button is available in the web client only and is

disabled by default. To activate this button, see Activate the command/search line toggle

button.

2. Type the record's prefix and ID in the Search Line, and then press Enter.

For example, type IM10005 in the Search line, and then press Enter. Record number IM10005

opens. However, if you type IM in the Search line and then press Enter, no records are displayed

because no ID is specified.

Note:

l The default records prefixes that can be searched for include SD (interactions), C (change), IM

(incidents), and CIs (configuration items). For more information about how to add a customized
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prefix for a record type, see "Add a prefix for a record type" on page 82.

l If you try to search a record when the Command/Search line toggle button is set to the

command line, the system displays the following message:

Unrecognized command. Reenter.

l If you try to search for a table or a non-existent record in Service Manager when the

Command/Search line toggle button is set to the Search line, the system displays the following

message:

No records found.

Advanced search
With advanced search, you can select from several types of search criteria to limit a search to help you

locate a specific record or group of records when there is a large number of records in a table. The

search provides two entries where users can specify a table to search (Look For) and a view to search

(View). In addition to these two entries, the following tabs are available to further define a search.

Note: Not all these tabs are available for all tables, as not all tables include all the search criteria

available on each tab.

l The Table tab identifies the table being searched (for example, Change or Incident). This tab

includes the main fields for the table being searched. Smart Search is used so that the search

automatically includes the ID prefix ( IM for incident records) as part of a record number search. For

example, when you search for record number 1003, the search will locate IM1003. This tab also

includes more choices (checkboxes) that provide additional search criteria to further limit a search.

l The Advanced Filter tab enables users to create and save filters for advanced searches that locate

a specific set of records, such as all interaction records closed after a certain date. A wizard helps

users construct a complex query that combines various search criteria and compounds to create an

advanced search. The selections include all available fields for the table you are searching with

comparison criteria based on the data type of the field you choose. The Advanced Filter tab also

includes a Not check box, which gives you the ability to negate any search criteria or whole

compounds.
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l Where applicable, there is also a Text Search tab that enables you to search for text in IR Key fields

defined for the table in the dbdict. For example, an IR Key that has a description defined could be

searched for a text string.

Search for a record
Applies to User roles:

All roles

This topic demonstrates how to search for an incident record as an example of how to search for any

type of record or set of records in HP Service Manager. Most of the actions that are described below are

common to any record search. However, the search criteria that are available will depend on the fields

in the table that you are searching.

To search for an incident record, follow these steps:

1. In Incident Management, click Search Incidents.

2. Use the search form to specify additional search criteria to make your search more efficient. For

example, in the View field, select Open incidents assigned to my group.

3. For more search options, click the following tabs:
o Incident

You can leave any or all fields on this tab blank. For the fastest searching, use the fields

identified as key (indexed) fields at your site. If these fields are not clearly identified on the

form, ask your Service Manager administrator for a list of key fields. You can also select some

options that provide additional search criteria.

o Advanced Filter

Add new filter criteria to your search.

l To write your own search query to sort the results by keyed fields, click More or the More

Actions icon, and then select Expert Search.

l To specify the field, comparison, and value for the filter, click Add New Filter Criteria.

4. Click Search to display the list of records that matches your search criteria. Select a record in the

list to view it.

Note: If Service Manager generates a message that states no records were found, you can
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broaden the search by eliminating some of the search parameters. You can sort a record list

by clicking the header of the column that you want to sort. For example, to sort the list by

status, click the Status column header.

5. To modify or end your search, choose one of the following options:
o To clear the search criteria you selected and return to a blank search form, click Clear or press

Alt+F7.

o To start the Add a New Device wizard and add a new business service or device to your

configuration items, click New or press Alt+F1.

o To restore the search criteria you have cleared, click Restore or press Alt+F11.

o To end your search and return to the previous screen, click Cancel or press Alt+F3.

You can choose to create a new view, so that you have the query readily available the next time you

want to search for these records.

l In the web client, click More, and then select Save List as View.

l In the Windows client, click the More Actions menu (the down-arrow button on the far right of the

toolbar), and then select Save List as View.

Advanced filter
HP Service Manager provides a standard search screen for the main tables of each module. The search

screens provide the main fields to perform the search on the first tab as well as the capability to

perform more complex queries using the Advanced Filter tab. The Advanced Filter tab maintains search

functionality when migrating from Service Desk to Service Manager.

The Advanced Filter tab enables you to specify queries against any other field in the table in addition to

the fields that appear on the initial search screen. You can use the Advanced Filter wizard to combine

the fields with other expressions using either "and" or "or" operators as well as parentheses to create

complex queries. The comparison operators will vary depending on the field type that you select. On

array fields, the values will also change depending on whether you are searching on an array field that

has been configured to be used as an IR key or as a regular array. The "Is Null" and "Not Equal to"

operators allow you to search for records where a field is equal to a specified value or is null. A "Not"

checkbox appears as part of the wizard to help you create negated queries on any field except arrays

that are configured as IR keys.
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When you create a filter, you should consider that the execution time for the query may vary, depending

on the following factors:

l The number of records in the table

l The complexity of the query

l The use of non-keyed fields

We recommend that you try to avoid queries against non-keyed fields and avoid using multiple

negations that would cancel each other, such as not(not <field> <operator> <value>).

Create an advanced filter
Applies to User Roles:

All roles

The following example demonstrates how to use an advanced filter to search for a record or set of

records in HP Service Manager. In this example, a new advanced filter is created to search for a set of

records that satisfy the specified search criteria for incident records.

To create an advanced filter, follow these steps:

1. Click Incident Management > Search Incidents.

2. Click the Advanced Filter tab, and then click Add New Filter Criteria.

3. Select a field from Field in Incident to be part of the search criteria. For example, select

Assignment Group. If you do not find the fields that are appropriate for your search criteria (for

example, you want Manager Name as a field ), follow these steps:

a. From Field in Incident, select a field that is linked to a table that contains the field that you

want to add as search criteria. In this example, select Assignment Group from Field in

Incident, as the assignment table contains both the Manager Name and Assignment Group

fields.

b. Click Use Multi Level Chooser, select Manager Name from Incident Assignment Records, and

then click Next.

Note: Incident Assignment Records may not appear if the field you selected in step a is

not linked to any other table.
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4. Select a comparison from the drop-down list (for example, Equals). You can also negate the

operator field you select by selecting the Not check box, except for an IR field, which cannot be

negated.

5. Type or use Fill to select a value for the Value field. For example, enter the manager’s name, and

then click Next.

The new advanced filter is created, and the system now uses the filter to search for and display a list of

records that satisfy the search criteria you provided.
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Navigating the UI

The System Navigator
The System Navigator is a navigational structure to view menus, tables, fields, forms, and other integral

components. You can also create new nodes that give you quick access to triggers, links, incidents, and

personal favorites. The System Navigator simplifies switching forms, applications, and tools and enables

administrators to view forms, files, and links quickly.

Favorites
Favorites are frequently-visited forms, queries, business services, or links that you want to preserve for

quick navigation. If you bookmark a favorite query, that query runs each time that you click that link.

You can create, rename, copy, or delete the favorite. If you add a query to your Favorites list, HP Service

Manager re-runs the query each time that you select it. Service Manager supports both public and

private Favorites lists.

Personalization
You can define your own business view of records, incidents, contacts, and so on. By customizing the

System Navigator and adding folders for different activities or watch lists, you can easily review all your

high priority information.

Note: Do not use the browser buttons (such as Refresh, Back, and Forward) on your browser

toolbar or their keyboard shortcuts (such as Ctrl+R, Ctrl+Left, and Ctrl+Right) to navigate the

Service Manager UI in the web client. Instead, use the buttons on the Service Manager interface, as

described in the ""List and detail toolbars" on page 46" topic.

Menus
The HP Service Manager Services, Support, Utilities, and Toolkit menus appear after you log on to

Service Manager. The main menu provides access to all Service Manager applications. The number of

HP Service Manager (9.41) Page 55 of 94



menu items that are displayed depends on your user role and on the capability words that you are

assigned. For example, if you have administrator rights, all menu items are displayed.

Menu Purpose

Applications Accesses the main Service Manager applications.

System Administration Accesses utilities that administer Service Manager.

Tailoring Accesses applications that tailor Service Manager.

More Actions menu
The More Actions menu contains various actions and functions that apply to the specific record list or

detail form that you have open. The menu items available for each list or detail form vary based on your

user profile, your permissions, and how HP Service Manager was implemented at your location.

To access the More Actions menu on a web client, click the More button.

To access the More Actions menu on a Windows client, click the down-arrow button on the far right of

the toolbar.

Switching the System Navigator
By default, the System Navigator is displayed in the left-hand panel of the Service Manager interface.

Web client

In the web client, you can switch the System Navigator between the following two modes:

l Sidebar mode

In the sidebar mode, the System Navigator only displays the icons of the top-level menu items. When

the mouse hovers over an icon, a pop-up menu immediately appears on the right side of this icon

and displays the submenu. In this mode, the System Navigator is only about one-third as wide as in

the accordion mode. The sidebar mode provides more working space and offers better efficiency for

you to locate a menu item.

Note:
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o The sidebar mode only works in Power User view (index.do) and Employee Self-Service view

(ess.do), but does not work in Accessible view (accessible.do) and Self-Service Accessible

view (accessible_ess.do).

o The sidebar mode is designed for users who have normal vision. Therefore, when the focus is

on an icon in the sidebar mode, JAWS does not read the name of the item, but notifies the

user to switch the System Navigator to the accordion mode.

l Accordion mode

The accordion mode uses both icons and text. In addition, the accordion mode allows you to manage

favorites.

You can switch the System Navigator to the sidebar mode by clicking the Collapse Navigator (<<)

button. Click the >> button to switch to the accordion mode. Alternatively, you can use the Alt+N

keyboard shortcut to toggle between the two modes.

Your web browser can remember the current mode of the System Navigator when you log out, and the

web client keeps the same mode in your next login. If you clear the cache of the web browser, the

System Navigator is in the accordion mode in your next login.

Windows client

In the Windows client, you can collapse or hide the System Navigator to increase space on the screen for

regular activities. To do this, click the Minimize button on the right side of the panel toolbar. To display

the panel again, click the Restore button on the far left of the screen.

Menu item order in the System Navigator
By default, menu items in the HP Service Manager System Navigator are displayed in ascending

alphabetical order. You can disable this option so that menu items are displayed in the order in which

they arrive from the server. Additionally, system administrators can group menu items to make it easier

for end users to navigate within the system.

In the web client, the alphabetical sorting of System Navigator menu items is defined by the

sortNavItems parameter in the web.xml file. The default is "true" (enabled).
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In the Windows client, the alphabetical sorting of System Navigator menu items is defined by the "Sort

menu items alphabetically in the System Navigator" option. To configure this option, click Window >

Preferences > HP Service Manager > Appearance.

Change the System Navigator menu item order option
Applies to User Roles:

Administrator

Web client

To change the System Navigator menu item order option in the web client, set the following parameter

in the web.xml file:

<init-param>

<param-name>sortNavItems</param-name>

<param-value>true</param-value>

</init-param>

The default value of the parameter is "true" (enabled).

Windows client

To change the System Navigator menu item order option in the Windows client, follow these steps:

1. Click Window > Preferences.

2. Expand HP Service Manager.

3. Click Appearance.

4. Clear the Sort menu items alphabetically in the System Navigator option to disable alphabetical

sorting. Or, select the Sort menu items alphabetically in the System Navigator option to enable

alphabetical sorting.

Add a folder to the System Navigator
Applies to User roles:
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All roles

Windows client

To add a folder to the System Navigator in the Windows client, follow these steps:

1. Right-click the parent node and choose New Folder.

2. Type the name of the new folder.

3. Click OK.

Web client

To add a folder to the System Navigator in the web client, follow these steps:

1. Click Manage Favorites.

2. Expand the Favorites directory to locate the parent node.

3. Click Add folder or dashboard, and then select New Folder.

4. Type the name of the new folder.

5. Click OK.

Collapse open folders in the System Navigator
Applies to User roles:

All roles

To collapse the open folders in the System Navigator in the Windows client, right-click the parent node,

and then click Collapse All to close all the subordinate child nodes.

Note: This feature is not available in the web client.

Delete a node in the System Navigator
Applies to User roles:
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All roles

Windows client

To delete a System Navigator node in the Windows client, right-click the nodes in the System Navigator,

and then click Delete.

Web client

To delete a System Navigator node in the web client, follow these steps:

1. Click Manage Favorites.

2. Expand the Favorites directory and select the node that you want to delete.

3. Click Delete.

Note: You can permanently delete nodes that you create only. If you delete a node that is common

to all users, it reappears when you refresh the connection.

Accessing an application
You can access applications from the System Navigator. You can expand nodes in the System Navigator

to see all available applications and tasks at the same time. You can create favorites that make any

part of HP Service Manager, or a frequently used query, accessible with a single click. The System

Navigator can remain visible while you work in any application, which enables quick transitions to other

tasks and forms.

To use a particular application, click the name of the application. For example, click Service Desk >

Create New  Interaction to open the New Interaction form and add information.
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Views and favorites
Views and favorites enable you to define and save a query. For example, the following out–of–box views

or favorites are queries that generate record lists:

l Calls I opened

l High priority problems

l All my approvals

l My tasks

l Active contracts

l All my open requests

When you display the contents of a view or favorite, the query that is associated with it automatically

runs and produces the list of records that meet the query criteria. Favorites appear in the System

Navigator under Favorites and Dashboards. Views appear as queues within most HP Service Manager

applications. Whether you access the record list from Favorites and Dashboards, or a view from an

application, the list of records in each is identical.

You can create favorites if you have the user.favorites capability word in your profile. You can share

favorites with other users if you have the public.favorites capability word in your profile. Service

Manager stores favorites as unique records in the inbox table.

Public and private favorites
Any user can create private favorites (such as common queries and frequently used forms) for their

own use if their profile contains the user.favorites capability word. A named user who has the

public.favorites capability word in their profile can share their private favorites and dashboards with

other users. Only the owner of a favorite or a system administrator can modify the favorite properties.

The public.favorites capability word is only for administrators to create and modify shared favorites. An

administrator can create a favorite for an individual user, user groups, or the entire user community,

and then specify one or more content owners. A designated content owner cannot remove the favorite

folder, but they can define or modify subordinate folders or dashboards.
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Add a view or favorite
Applies to User Roles:

All roles except Self-Service User

You can use Add Favorite to define and save a query. When you save a record list as a favorite, you are

saving a dynamic query that extracts information from the database. When the database changes, the

resulting output changes.

Windows client

To add a view or favorite in the Windows client, follow these steps:

1. Navigate to the HP Service Manager form or application that you want to save as a view or favorite.

Or, enter search criteria to find the record or list of records that you want to save, and then click

Search.

2. Click the System Navigator icon and drag it to Favorites and Dashboards or to a subordinate

favorites folder.

3. Type a name for the new favorite.

4. Click OK. Service Manager displays the new favorite at the bottom of the Favorites and Dashboards

folder.

Web client

To add a view or favorite in the web client, follow these steps:

1. Navigate to the Service Manager form or application that you want to save as a view or favorite.

You can also enter search criteria and then click Search to find the record or list of records that

you want to save.

2. Click the Add Favorite button in the Record List toolbar or the Detail List toolbar to save the record

list or the single record.

3. Type a name for the new favorite.
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4. Click OK. Service Manager displays the new favorite in the Favorites and Dashboards folder.

Note: You cannot add a favorite in a workflow page.

Private favorites: You can create favorites only if you have the user.favorites capability word in your

operator record.

Public favorites: You can share favorites with other users only if you have the public.favorites capability

word in your profile. If you create a public favorite and store it in the Favorites and Dashboards parent

node, the favorite is available to all users. If you create a public favorite, and store it in a node that is

subordinate to the Favorites and Dashboards parent node, the availability of the favorite depends on

the properties of the parent node.

Contact your administrator if you cannot create favorites.

Edit a view or favorite
Applies to User Roles:

All roles except Self-Service User

You can edit a view or favorite to change the title, the query, or the view definitions. Additionally, you

can move or copy views and favorites to other folders.

Windows client

To edit a view or favorite in the Windows client, follow these steps:

1. Click Favorites and Dashboards.

2. Right-click the favorite that you want to edit, and then select Properties. The View Definition form

opens.

3. Update any fields that require revision, click Save, and then click OK.

To move or copy the view or favorite, click the view or favorite and drag it to the new destination.

Web client

To edit a view or favorite in the web client, follow these steps:
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1. Click Manage Favorites in the Navigator pane.

2. Expand a favorite folder to display all the favorite links in the folder.

3. Click the associated check box to edit an individual favorite.

4. To edit the view or favorite:

a. Click the favorite text link. The View Definition form opens.

b. Update any fields that require revision.

c. Click Save.

d. Click OK.

5. To move the view or favorite:

a. Select the view or favorite you want to move.

b. Click Move To in the toolbar and select the destination folder.

c. Click Yes.

6. To copy the view or favorite:

a. Select the view or favorite you want to copy.

b. Click Copy To in the toolbar and select the destination folder from the drop-down list.

c. Click Yes.

Private favorites: You can create favorites only if you have the user.favorites capability word in your

operator record.

Public favorites: You can share favorites with other users only if you have the public.favorites capability

word in your profile. If you create a public favorite and store it in the Favorites and Dashboards parent

node, the favorite is available to all users. If you create a public favorite, and store it in a node that is

subordinate to the Favorites and Dashboards parent node, the favorite availability depends on the

properties of the parent node.

Contact your administrator if you cannot create favorites.

Delete a view or favorite
Applies to User Roles:
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All roles except Self-Service User

You can delete a view or favorite if it is no longer needed.

Windows client

To delete a view or favorite in the Windows client, follow these steps:

1. Click Favorites and Dashboards.

2. Right-click a favorite, and then select Delete.

3. Click Yes to confirm the deletion.

Web client

To delete a view or favorite in the web client, follow these steps:

1. Click Manage Favorites in the Navigator pane.

2. Expand a favorite folder to display all favorite links in the folder.

3. Select the associated view or favorite that you want to delete.

4. Click Delete in the toolbar, and then click Yes to confirm the deletion.
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Editing records
HP Service Manager applications enable users to access and edit records. Multiple users can view the

same record concurrently. If one of those users begins to modify the record, the server locks the record

for updates only from that user. When the user saves the record, the server unlocks it. One of the

following scenarios occurs when two users access the same record:

l If the record is being updated by another other user, Service Manager generates a message when

you attempt to change it. The record is locked until the other user completes the update.

l If the record is not in use, but you do not have the current version of the record, Service Manager

prompts you to refresh the record.

Note: Do not refresh the record by refreshing your browser. Instead, use the Service Manager

Refresh button.

To disable the pop-up window that appears when you reload a record, follow these steps:

a. Click System Administration > Base System Configuration > Miscellaneous > System

Information Record.

b. Click the General tab.

c. Select the Disable the Pop-up Window to Reload Records option.

d. Click Save.

l If the record is not locked and you have the most current version, you may continue typing without

interruption. Other users cannot update that record until you complete the update.

Service Manager applications also enable background process to access and edit records. When Service

Manager is integrated with other products, the background process updates the records automatically

in many cases. One of the following scenarios occurs when a user and a background process access the

same record:

l If you and the background process are updating different fields in the record simultaneously,

Service Manager generates a message after you save your update. The system merges the updated

fields automatically and integrates these fields into the record.

l If you and the background process are updating the same field in the record concurrently, Service
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Manager prompts you to merge the conflicted updates when you try to save your update.

To merge the conflicted updates manually, follow these steps:

a. Click Merge in the toolbar. The "Conflicts" section opens.

b. In the "Conflicts" section, select the value in one of the following fields:

l Original Value in DB: The original value of the field in the database.

l Current Value in DB: The current value in the database which is updated by the background

process.

l Unsaved Update: The unsaved value which is being updated by you.

c. Click OK to save the conflicted value with your selection. Or, click Cancel to return to the Details

page of the record with unsaved updates.

d. Click Save or Save & Exit to save the record to the database.

Note:

l The Merge button is available only when there are conflicted updates.

l The Merge Conflicted Updates feature is available for business data modules only, including

Change Management, Configuration Management, Incident Management, Problem

Management, and Service Desk.

l The merge function is available only when there are no conflicts on fields of the system usage

type. For more information about how to define the field usage type, refer to Data Policy.

Record list
The HP Service Manager database is a set of files that contains records. You can search, modify, create,

and delete these records. Records may contain information about the following items:

l Users

l Configuration items

l Interaction reports
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l Incidents

l Changes

l Requests

You can locate records by using a query, which is a search performed on the Service Manager database.

A record list query is a search of the database using the information you know about a specific record. If

Service Manager finds multiple records that match your search parameters, it displays a record list. You

can double-click any record from the list to view it in a form.

When you access a record, you can browse (view only) or update the record. Your ability to update the

record depends on your user profile. For example, a Service Desk user may not have permission to

approve a change record.

Alternate forms

System Administrators can modify Service Manager so that alternate forms are available to some

users. In this situation, the Alternate Forms option in the More Actions menu is available. User can select

the form to use to display the information. Administrators do this to display different views such as

financial or security information.

Administrators can specify alternate forms to display a list of records or to display a single record.

Enable or disable a record list

Applies to User roles:

All roles

To enable a record list in the Windows client, follow these steps:

1. Click Window > Preferences.

2. In the Preferences dialog box, expand HP Service Manager.

3. Click Appearance, and then select Show detail pane with record list.

4. Click Apply, and then click OK.

To disable a record list in the Windows client, follow these steps:
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1. Click Window > Preferences.

2. From the Preferences dialog, expand HP Service Manager.

3. Click Appearance, and then clear the Show detail pane with record list option.

4. Click Apply, and then click OK.

Note: This method is only available in the Windows client and does not work in the web client.

Create customized column views for record lists

Applies to User roles:

All roles

To create customized column views for record lists, follow these steps:

1. Click More or the More Actions icon.

2. Click Modify Columns to display a form that enables you to select the columns (fields) that the

record list displays.

3. Modify the columns as desired. For more information about how to do this, see "Change the

columns in a record list" on page 1.

4. Click More or the More Actions icon.

5. Click Save as Named Grid, type a name for your new grid, and then click OK.

Note: You can repeat this process for each view that you want to create.

Invoke a saved column view

Applies to User Roles:

All roles

To invoke a saved column view, follow these steps:
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1. Display any record list.

2. Click More or the More Actions icon.

3. Click Modify Columns, click More or the More Actions icon again, and then select Load Named

Grid.

4. Click the drop-down list to choose the name of a saved column view (grid), and then click OK.

Delete all saved column views

Applies to User Roles:

All roles

To delete all saved column views, follow these steps:

1. Display any record list.

2. Click More or the More Actions icon.

3. Click Modify Columns.

4. Click More or the More Actions icon again, and then select Clear Saved Grids.

Working with record lists

Note:

l As of HP Service Manager 9.31, the RecordList functionality in the web client has been improved

to achieve better performance and usability. To learn about the differences between the old

and new RecordList functionality, see "RecordList improvements (web client)" on page 79.

l Unless noted otherwise, record lists function similarly in the web and Windows clients.

The following figures depict the components of the list/detail and list-only record list pages in the web

client.
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List/detail page (web client)

1. List pane: The record list is displayed on this pane.

2. Detail pane: The details of a record are displayed on this pane.

3. List toolbar: Contains options that take effect on the entire list or selected rows in the list.

4. Selected rows: Selected rows are highlighted but without a black border.

5. Focused row (in the unselected state in this figure): The row that is currently in focus. The focused

row has a black border and a blue (when selected) or dark gray (when unselected) background.

When selected, the focused row is also a selected row. Keyboard operations take effect only on the

focused row (not on selected rows). For example, pressing Enter drills down to the focused row.

6. Page size selection box: Defines how many records are displayed on each page.

7. Paging bar: Allows users to navigate through the pages of the record list.
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8. Checkbox: Indicates whether the row is selected.

9. Truncated records:

List-only page (web client)

1. Drill-down link: Each cell in the first column is a drill-down link. Clicking a link opens the details of

the record in the detail pane.

2. Group: A group in the record list (in the collapsed state in this figure).

3. List toolbar

4. Selected rows

5. Focused row (in the selected state in this figure)

Select multiple records

Note: You cannot use only the Shift key to select a range of records that span multiple groups or

pages. You can press Ctrl+Shift to select records that span multiple pages, but you cannot do so for

records that span multiple groups.

Getting Started help topics for printing

Editing records

HP Service Manager (9.41) Page 72 of 94



To select multiple records, use one of the following methods:

l Hold down the Ctrl key and click multiple rows. To deselect a row, click the row again.

l Hold down the Shift key, click one row, and then click another row to select a range of rows. To

deselect a row, hold down the Ctrl key and click the row again.

To select multiple records in the web client, use one of the following methods:

l Select the check boxes of multiple rows. Clear the check box to deselect a row.

l Hold down the Ctrl key, and click multiple rows. Click a row again to deselect it.

l Hold down the Ctrl key, press the Up or Down key, and then press the Space key to select multiple

rows one by one. Press the Space key again to deselect a row.

l Hold down the Shift key, click one row, and then click another tow to select a range of rows. To

deselect a row, hold down the Ctrl key and click the row.

l Hold down the Shift key, and press the Up or Down arrow key to select a range of rows. To deselect a

range of rows, hold down Shift and press the Up or Down key again. To deselect a row, hold down Ctrl

and press Up or Down to move the focus to the row and press the Space key.

Expand/collapse a group

In the web client, you can expand only one group in a record list at one time. The grouping behavior

varies depending on the viewrecordlist setting (no matter whether it is set in the server's sm.ini file, in

the web tier configuration file (web.xml), or in the web client login URL).

l If the viewrecordlist setting is set to true:

Service Manager always expands the group in which the current row is located. By default, when you

initially open a record list, the first row is the current row (therefore, the first group is expanded). In

list/detail pages, the current row is the row currently displayed in the detail pane. In list-only pages,

the current row is the last selected row. Whenever a record list page is reloaded (for example, when

you sort the record list), Service Manager expands the group in which the current row is located.

The following table describes the different ways in which you can change the current row in the

list/detail and list-only pages in the web client.
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In list/detail pages In list-only pages

You can change the current
row in either of the following
ways:

o Click a row (not the
checkbox of a row, which
allows multi-select).

o Use the Up or Down key to
move the focus to a row
(without holding the Ctrl or
Shift key)

Select a row to change the current row. The last selected row is
the current row.

Note: It does not matter how you select the row (for
example, by clicking the row, by selecting the checkbox, or
by using the Up or Down key or the Ctrl+Up/ Down+Space
keys).

l If the viewrecordlist setting is set to false:

Whenever a list-only record list is reloaded (for example, when you refresh or sort the list), the first

row in the list becomes the current row and is expanded.

To expand or collapse a group in the web client, use one of the following methods:

o Click the plus/minus (+/-) symbol of a group.

o Use the Tab key to move the focus to a group and then press the Right or Left arrow key.

o Use the Tab key to move the focus to a group and then press the Space key.

To expand or collapse a group in the Windows client, use one of the following methods:

o Click the plus/minus (+/-) symbol of a group.

o Use the Tab key to move the focus to a group, and then press the Right or Left arrow key.

Sort a record list

To sort a record list in the Windows client, use one of the following methods:

l Click a column header to resort the list using that column’s information. For example, to sort the list

by status, click the Status column header.

l Click again to reverse the order (for example, from ascending to descending).

To sort a record list in the web client, use one of the following methods:
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l Click a column header.

l Use the Tab key to move the focus to a column header and then press Enter.

Drill down to a record

When you drill down to a record, the details of a record are displayed in the detail pane.

To drill down to a record in the web client, use one of the following methods:

l In the list-only view: Click the link in the first column of a row, or double-click a row.

l In the list/detail view: Click a row.

l In both views: Press the Up or Down arrow key to select a row and then press Enter.

Note: If the focus moves to a collapsed group, press the Space key or the Right arrow key to

expand the group and then continue.

To drill down to a record in the Windows client, use one of the following methods:

l In the list-only view, double-click a record.

l In the list/detail view, click a record.

Count the records in a list

To count the records in a list in the web client, use one of the following methods:

l Click the Count Records button located below the record list.

l From the list toolbar, click More, and then select Count.

l Click the last page number on the paging bar or press the Tab key until the focus moves to the last

page number, and then press Enter.

To count the records in a list in the Windows client, click the Count Records button located on the right

side of the record list Toolbar.
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View content that has been truncated to fit in a column

If the content of a column cannot be fully displayed within the configured column width, the content is

truncated and appended by an ellipsis (...). To view the truncated content, hover the mouse over it. After

a short time, the content appears in a tooltip, as displayed in the following image.

Change the page size (web client only)

Use the page size selection box located below the record list to select the number of records that are

displayed on each page.

Navigate through pages (web client only)

You can use the controls on the paging bar below the record list to view the records, page by page.

The following figures summarize the paging bar behavior.

l There are up to 10 page links on the paging bar. If there are more pages after or before the last or

first page link, an ellipsis ("...") is displayed.
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l If you do not click the Count Records button, the paging bar remembers the largest page number

that you have visited.

l When you click the Count Records button or reach the last record in the list, the Count Records

button is replaced by the record count of the current page. For example, "1 to 25 of 302".

Move the focus using the keyboard

Use the Tab key to move from a detail record back to the record list. Press Tab to move forward or

Shift+Tab to move backward through the fields of a detail record until the focus returns to the record

list pane. Once the focus is positioned in the record list, you can scroll through the list of records by

using the up and down arrow keys. When you move the focus to a record you want to view, press Enter.

Set the focus on a record for keyboard actions (web client

only)

Keyboard actions take effect only on the focused row. For example, pressing Enter selects and opens

the focused record, instead of a selected record.

To set the focus on a record for keyboard actions in the web client, use one of the following methods:

l Click a row.

l Press the Up or Down arrow key to select a row.

Show or hide columns (web client only)

To show or hide columns, follow these steps:

1. Move the mouse to any column header.

2. Click the
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icon. A drop-down menu appears.

Note: If you want to sort the record list by a column, click the column name.

3. Select or clear the check box before a column name to show or hide the column.

Note:

l By default, the list pane only displays the first four columns in the vertical layout.

l You cannot hide the first column.

l The columns that appears in the drop-down menu are configurable. For more information, see

"Create customized column views for record lists" on page 69.

l The content in the drop-down menu does not support JAWS because this menu is provided for

users who have normal vision.

Switch on or off the color indicator for a column

In the record list, you can quickly switch on or off the color indicator of a column. To do this, use the

Color Indicate option in the drop-down menu of that column.

Change the width of a column

To change the width of a column, follow these steps:

1. Position the mouse pointer in the column heading near the cell border until it appears as a double-

headed arrow.

2. Perform one of the following actions

o Drag the column boundary to the left or right until the column is the desired width.

o Double-click the mouse to restore the default width of the column.
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Change column definition and order

There is a default order to the columns that appear when you display a record list. Your administrator

can determine the order, or you can create a personal view that orders columns according to your

preference. Each view that you define has a unique name.

Zoom in or out record lists (web client only)

To zoom in or out record list pages in the web client (including the text and images), press the Ctrl key

together with the plus or minus key (+/–) or together with the mouse wheel.

RecordList improvements (web client)
As of HP Service Manager 9.31, the RecordList functionality in the web client has been improved to

achieve better performance and usability. For more information about working with record lists, see

"Working with record lists" on page 70.

Usability improvements in the new RecordList

l On a list-only page (for example, a To-Do queue), the first visible column in each row is a drill-down

link. If you click this link, the record opens.

l On a list-only page, a single click on a row no longer opens the record (it selects the row instead).

l The focused row now has a black border and an orange or gray background (when selected and not

selected, respectively), while selected rows only have an orange background.

l More keyboard operations are supported.

Differences between the old and new RecordList functionality

The following table summarizes the major differences between the old and new RecordList behaviors.

Concept Description
Before version
9.31 In version 9.31 or later

Focused
row

This is the row where
the focus is set for
keyboard actions
(unique).

To set the focus
on a row, use one
of the following
methods:

To set the focus on a row, use one of the
following methods:

l Click a row.
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Concept Description
Before version
9.31 In version 9.31 or later

l Hold down
the Ctrl key,
and click a
row.

l Press the Up
or Down
arrow key to
move the
focus to the
row.

l Press the Up or Down arrow key to move
the focus to the row (This will clear
previous selections).

l Hold down the Ctrl key, and press the Up
or Down arrow key to move the focus to
the row (This will keep previous
selections).

Single-
select

Select a single row for
list toolbar options
(unique).

Not supported To select a single row, use one of the
following methods:

l Click the row (not the checkbox).

l Press the Up or Down key to move the
focus to the row.

Multi-
select

Select multiple rows for
list toolbar options.

Select the
checkboxes of
the rows.

To select multiple rows, use one of the
following methods:

l Select the checkboxes of the rows. To
deselect a row, clear the checkbox.

l Hold down the Ctrl key, and click the
rows. To deselect the focused row, press
the Space key; to deselect a selected
row, click the row again.

l Hold down the Shift key, and click the
first and last rows. To deselect the
focused row, press the Space key; to
deselect a selected row, click the row
again.

Drill
down

On a list-only page:
Open the details of a
row (record).

On a list/detail page:
Refresh the detail pane
to display the details of
a row (record).

To drill down, use
one of the
following
methods:

l Click the row.

l Press Enter
to drill down
to the
focused row.

To drill down, use one of the following
methods:

l List-only: Click the link in the first column
of a row, or double-click a row.

l List/detail: Click a row.

l Both views: Press the Up /Down arrow
key to select a row and then press Enter.
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Mouse/keyboard action improvements

The following table provides a comparison between the mouse and keyboard actions of the old and new

RecordList, for list-only and list/detail pages. The actions are identical for both views unless otherwise

specified.

User's
Mouse/Keyboard
Operation Old Action New Action

Click a row Drills down to
the record
(updates the
detail pane).

List-only: Selects the row.

List/detail: Selects the row, and drills down to the row (updates
the detail pane).

Press the Ctrl
key+ click on a
row

Sets the focus
on the row.

Selects or deselects the row.

Press the Shift
key + click on
multiple rows

Not supported Selects or deselects a range of rows.

Select or clear a
checkbox

Select or
deselects the
row (Multi-
select is
allowed).

Selects or deselects the row.

Press the Up or
Down arrow key

Moves the
focus up/down.

Deselects existing selected rows, and moves both the focus and
selected row up/down.

Press the Ctrl
key + Up or Down
arrow key

Moves the
focus up/down.

Keeps existing selected rows, and moves the focus up/down.

Press the Shift
key + Up or Down
arrow key

Not supported Selects a range of rows.

Press the Space
key on the
focused row

Selects or
deselects the
row. (Multi-
select is
allowed)

Selects or deselects the row.

Press Enter on
the focused row

Drills down to
the focused
row.

Drills down to the focused row.

Click the drill- Not supported List-only: Drills down to the row.
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User's
Mouse/Keyboard
Operation Old Action New Action

down link List/detail: Not supported

Double-click a
row

Not supported Drills down to the record.

Refresh or sort a
list-only record
list

Collapses all
groups,
regardless of
the
viewrecordlist
setting.

If viewrecordlist is set to true: Expands the group that
contains the current row (that is, the last selected row).

If viewrecordlist is set to false: Expands the first group in the
list (the first row becomes the current row).

Note: When a list-only page (a ToDo list or Fill list) is initially
opened or reloaded (refreshed or resorted), the current
row (either the first row or the last selected row) is only
focused but not selected, regardless of the viewrecordlist
setting.

Add a prefix for a record type
The default records prefixes that can be searched for include SD (interactions), C (change), IM

(incidents), and CIs (configuration items). To search for a record type which does not have an out-of-box

prefix (for example, approvals), you need to add a prefix for this record type.

To add a customized prefix for a record type, follow these steps:

1. Log on to HP Service Manager as a System Administrator.

2. Type gl on the command line, and then press Enter.

3. Type Universal Search Customize List in the List Name field, and then click Search.

4. Add a record type with the corresponding prefix.

For example, to add an approval record, type "Approval" in the Value List field and then type

"A" in the Display List field as the prefix.

When you add multiple record types and prefixes, make sure the types and prefixes are within

double quotation marks and separated by commas with no spaces between them. For example:

{"svcCartItem","Approval"} and {"sci","A"}.

5. Click Save, and then click OK.
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When you search for "A10232" by using the HP Service Manager search line, the approval record with

the ID of 10232 is displayed.

Printing lists and records
You can print record lists and record details from the HP Service Manager Windows client.

To print the record list or record details, follow these steps:

1. Use search or advanced search to display a list of records or the details of a specific record.

2. Click File > Print. Or, click the Print icon and select List View to print the list of records or Detail

View to print a single record.

Note: This functionality is not present in the web tier.

Using Quick Jump in record detail
When the record detail is displayed in groups, you can use the Quick Jump feature to navigate to the

desired section in record detail.

Note: For more information about how to configure the display style of the record detail, see

Preferred Notebook Style in Set home page preferences.

You can expand the drop-down list and then click one of the section names to jump to the section.
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Alternatively, if you type the section name in the text box, the matching section names then appear in

the drop-down list. You can use the up or down arrow to select a section name and then press Enter to

jump to the section.

You can also use the three buttons on the top of the drop-down list:

l Expand All: Expand all first-level sections in the record detail.

l Collapse All: Collapse all first-level sections in the record detail.

l Back To Top: Go back to the top of the record detail.

Fields
Fields are areas of a form in which information for a record is displayed. For example, that information

might be an asset name or the description of an incident. You can type information into some of these

fields. HP Service Manager fills the other fields automatically.

When you type new data in a field and click Save, Service Manager stores the data in the appropriate

Service Manager records.

Required fields

Required fields contain the information that is necessary to complete a form. For example, if you create

an incident record, you must specify a category. A red asterisk is displayed to the left of a required field.

If you do not type data in a required field before you save the record, Service Manager generates an

error message. In some forms, the message includes a list of possible values.

Protected fields

You cannot edit protected fields. For example, you cannot change the incident number when you view an

existing incident record. The fields that are protected depends on the form and your user rights.

Tabbing through fields

To tab through fields, press Ctrl+Tab. If you use the Tab key, Service Manager processes the Tab

character as the content of the field and treats it as invalid data for multi-line text fields. However, you

can use the Tab key to tab through regular input fields, such as fill fields or comfill fields.
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View Field Help

Applies to User roles:

All roles

Field Help can help you understand the use and function of each field or control on a form.

Note: In the web client, make sure the disableKeyHelp parameter is set to false before you view

Field Help.

To view Field Help, follow these steps:

1. Insert the cursor in a field or click a control (such as a check box) on the form.

2. Perform one of the following actions:
o In the Windows client, press Ctrl+H.

o In the web client, press F1 or Shift + F1.

HP Service Manager displays the help information for the current field or control. "No description" is

displayed if no help text is available.

Note: Service Manager also displays the file name, format name, and field name of the current

field or control, if one of the following conditions is fulfilled:

l In the Windows client, the “Show context-sensitive help debug information” preference is

enabled.

l In the Web client, “viewcontexthelp=true” is appended to the URL before you log in. The

“viewcontexthelp” is only supported in Power User view (index.do).

You can use such information to add or edit a field help record, or add a stored query using certain

field names.

Fill function
The Fill function allows you to create or update a record quickly. When you click the Fill icon next to an

empty field or a field that contains partially-keyed leading information, HP Service Manager identifies

the applicable related record and adds the related information to the field. For example, if you type Br
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in a name field and click the Fill icon, HP Service Manager identifies records with last names that begin

with "Br,"such as the record for Nicholas Brown, along with any assets that are linked to this contact

record.

Note: If you attempt to locate information for a field that depends on one or more fields that

contain invalid or unrelated information, you receive an error message that resembles the

following:

Cannot find related information in dept using query: company#"advantage" and
dept.full.name#"advantage/edd"

In this example, the value of the department name field depends upon the values in the company

and dept.full.name fields. You must provide valid values in the company field and dept.full.name

field.

Use the Fill functionality

Applies to User Roles:

All roles

To use the Fill functionality, follow these steps:

1. Insert the cursor in any field that has a Fill icon adjacent to the text field.

2. Perform one of the following actions:
o Click the Fill icon adjacent to the field.

o Press F9.

3. A record list that contains possible entries for the selected field is displayed. Double-click a record

to fill the selected field and any related fields.

Use the Fill Selected functionality with multiple records

Applies to User Roles:

All roles

The Fill Select functionality is available for array fields only. An array field is a field that accepts a list of

entries rather than a single entry. This topic describes how to use the Fill Selected functionality to add

Downstream CIs to a Configuration Item Relationship as an example of how to use the Fill Selected
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functionality with multiple records. This example was selected because the Downstream CIs field is an

example of an array field. This example uses out-of-box data for Applications CI.

Note: The multi-select functionality must be enabled by a System Administrator.

Windows client

To use the Fill Selected functionality to add multiple items to an array field, follow these steps:

1. Click Configuration Management > Resources > Configuration Item Relationships.

2. Click Search to display a list of existing Configuration Item Relationships, and then select

Applications.

3. Select the next available blank line in Downstream CIs, and then click the Fill icon for the entry.

4. Click Search or type search criteria, and then click Search.

5. To select multiple items from the list, follow these steps:

a. Click an item in the list.

b. Press and hold down the Ctrl key.

c. Select another item in the list.

d. Continue to hold down the Ctrl key while you select other items in the list, until you have

selected several items.

6. Click Fill Selected. The items that you selected are added to the list of Downstream CIs.

Web client

Note: In the web client, you can select multiple records to fill on one page at a time only.

To use the Fill Selected functionality to add multiple items to an array field, follow these steps:

1. Click Configuration Management > Resources > Configuration Item Relationships.

2. Click Search to display a list of existing Configuration Item Relationships, and then select

Applications.

3. Select the next available blank line in Downstream CIs, and then click the Fill icon for the entry.
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4. Click Search or type search criteria, and then click Search.

5. To select multiple items from the list, follow these steps:

a. Select the check box next to the records that you need from one page.

b. Click Fill Selected.

Find function

Note: Starting with Service Manager 9.41, the Find button is renamed to View Detailed

Information , and its icon image is also changed.

Certain fields in a record are linked to related information in different files. The Find function locates

associated records for fields such as asset, logical or contact names, locations, vendors, or users. For

example, when you use the Find function, you can populate the Reported By field in an incident record.

The function behaves differently for reference fields and normal fields (which do not have a referenced

table defined in the data policy).

Behavior on normal fields

For fields that are not a reference field, the View Detailed Information function uses the line in the link

record for its query.

l In the web client, the View Detailed Information button becomes active immediately after the user

starts typing in the field.

l In the Windows client, the button is disabled when the field is empty.

You can view or modify a linked record within the record’s application. Depending on your user profile,

you may be able to view Asset Management records, but not modify those records.

Note: If you attempt to locate information for a field that depends on one or more fields that

contain invalid or unrelated information, you receive an error message that resembles the

following:

Cannot find related information in dept using query: company#"advantage" and
dept.full.name#"advantage/edd"
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In this example, the value of the department name field depends upon the values in the company

and dept.full.name fields. You must provide valid values in the company field and dept.full.name

field.

Behavior on reference fields

The View Detailed Information function no longer uses the query defined in the link line; instead, the

system performs an exact match query based on "id".

l In the web client, only when the reference field contains a value that exactly matches a value in the

referenced table, the button is enabled (otherwise it is disabled).

l in the Windows client, the button is disabled when the field has no reference value (either you enter

a value without clicking Fill or the field is empty).

Use the Find function

Applies to User Roles:

All roles

To perform a find on data in tables, double-click the first item in the table. (If you are using the web

client, you only need to click once.)

To perform a find in other locations, follow these steps:

1. Insert the cursor in a field where you want to view the related HP Service Manager records. You can

enter partial data in a field to narrow the search.

2. Perform one of the following actions:
o Click the Find icon at the end of the field.

o Press F8.

Service Manager displays a record that contains information related to that field. If no records are

found or the selected field is not linked to the Find function, Service Manager generates an error

message.

To exit the related record, click Cancel.

Note: Find does not insert the information from the related record. Use the Fill function to enter

data automatically.
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Smart Indicator function
The Smart Indicator provides information on related issues, and enables you to drill down to this data

quickly in order to troubleshoot a user's issue. Smart Indicators can be configured to display the

following information:

l Any other open or closed interactions and incidents that belong to the user

l Incidents associated with the same service or configuration item (CI)

l Known errors for a service (this enables you to immediately communicate information related to the

service to the user)

Use the Smart Indicator function

Applies to User Roles:

All roles

Smart Indicators can be configured to display the following information:

l Any other interactions and incidents that were open and closed for the same service user

l Incidents associated with the same service

l Incidents associated with the same configuration item (CI)

Smart Indicators can also be configured to show known errors for a service, which enables you to

immediately communicate to a caller information that is related to the service.

The following steps provide an example of the Smart Indicator function in use. In this example, a user

contacts Service Desk to report an issue with their printer. The issue is first created by a Service Desk

Analyst as an interaction, escalated to an incident, and then analyzed by an Incident Analyst. During this

process, the Smart Indicator is used to browse through other interactions and incidents to look for

issues that are associated with the service and CI.

Service Desk Analyst
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1. Log on to HP Service Manager and open an interaction for the employee Aaron Caffrey.

2. Click the Smart Indicator icon to the right of Aaron's name to check whether he is calling about an

existing interaction.

3. To identify this issue with the Printer service, click Fill.

4. To see if this issue is already reported, click the Smart Indicator icon next to the service (image).

A wizard opens to gather more information about this service. This wizard enables you to perform

the following actions:

o Double-click a line to browse through and drill down to a detailed overview of the open

incidents, closed incidents, or possible workarounds for this service.

To exit the related record, click Cancel, OK, or Close.

o Click Next to return to the interaction record.

5. Click Fill to identify the primary CI.

6. Click the Smart Indicator for the affected CI.

7. Type the title and a description of the incident.

8. Categorize the interaction as: Incident, Failure, and Function or Feature not working.

9. Fill out the Impact, Urgency, and then click Escalate.

10. Select the Location, which helps determine how a new incident will be created and routed for

assignment. An incident is created in the background and you are returned to your original

interaction record. From here, you can let Aaron know what his Service Level Agreement (SLA)

target time will be and that someone will be working to resolve his incident.

11. Log out of Service Manager. An Incident Coordinator now assigns the new incident record to an

Incident Analyst.

Incident Analyst

1. Log on to Service Manager, locate the incident record in your To Do queue, and then accept the

incident record to begin your analysis.

2. Mark the incident as a candidate for the Knowledge Base.
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3. Create an activity record to describe how you reproduced the issue and how much time you spent

on the issue, and then log any other information.

4. Click the Smart Indicator icon for the Service and Affected CI fields to display the visualization

wizard that contains interaction and incident records with the same service and CI issue.

5. Double-click a line to browse through the records, and then drill down to a specific record for

details. Service Manager displays the record with information related to that field.

6. To exit the related record, click Cancel, OK, or Close.
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Send Documentation Feedback
If you have comments about this document, you can contact the documentation team by email. If an

email client is configured on this system, click the link above and an email window opens with the

following information in the subject line:

Feedback on Getting Started help topics for printing (Service Manager 9.41)

Just add your feedback to the email and click send.

If no email client is available, copy the information above to a new message in a web mail client, and

send your feedback to ovdoc-ITSM@hp.com.

We appreciate your feedback!

HP Service Manager (9.41) Page 93 of 94

mailto:ovdoc-ITSM@hp.com?subject=Feedback on Getting Started help topics for printing (Service Manager 9.41)



	About Service Manager
	Accessing HP Service Manager
	Logging on from the web client
	Log on to the web client (power user view)
	Log on to the web client (self-service user view)
	Log on to the web client (accessible views)

	Log on to the Windows client
	Create a connection
	Connections dialog
	Multiple sessions
	Windows client


	Log off Service Manager
	Passwords
	Change my password


	Clients
	Web client
	Web client views
	Parts of the web client interface
	Horizontal and vertical layouts
	Hover information in the vertical layout

	Accessibility
	Client differences: the accessible and standard Web clients
	HP Service Manager Accessibility Guide
	Using the web client in accessible mode

	Web client keyboard shortcuts
	Quick help for keyboard shortcuts


	Windows client
	Windows client features
	Parts of the Windows client interface
	Workbench
	System Navigator
	Client differences: System Navigator

	Editor
	Service Manager toolbar
	Shortcut bar
	Fonts
	Help menu
	Forms
	Link label
	Drag–and–drop feature

	Windows client keyboard shortcuts

	Differences between the Windows and web clients

	List and detail toolbars
	To Do list
	Searching records
	Search for a record by using the Search line
	Advanced search
	Search for a record
	Advanced filter
	Create an advanced filter

	Navigating the UI
	Menus
	More Actions menu
	Switching the System Navigator
	Web client
	Windows client

	Menu item order in the System Navigator
	Change the System Navigator menu item order option
	Add a folder to the System Navigator
	Collapse open folders in the System Navigator
	Delete a node in the System Navigator
	Accessing an application

	Views and favorites
	Public and private favorites
	Add a view or favorite
	Edit a view or favorite
	Delete a view or favorite

	Editing records
	Record list
	Enable or disable a record list
	Create customized column views for record lists
	Invoke a saved column view
	Delete all saved column views

	Working with record lists
	Show or hide columns (web client only)

	RecordList improvements (web client)
	Add a prefix for a record type
	Printing lists and records
	Using Quick Jump in record detail
	Fields
	View Field Help

	Fill function
	Use the Fill functionality
	Use the Fill Selected functionality with multiple records

	Find function
	Use the Find function

	Smart Indicator function
	Use the Smart Indicator function


	Send Documentation Feedback

